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EEEE 482 – Electronics II
Experiment #4: Design, Simulation, and Testing 
of NMOS Inverters
Objective
The goal of this lab experiment is to introduce the student to the design, simulation, and testing of NMOS inverter circuits. Circuits will be simulated using PSPICE, and basic inverters will be constructed and tested.
Introduction
One of the fundamental components in any digital system is the inverter.  The inverter is often referred to as a buffer since it can isolate one part of a digital circuit from another.  The earliest, simplest inverter was made of one transistor — an n-type FET (NFET or NMOS) — and a resistor.  The transistor is referred to as the driver and the resistor is referred to as the load.  Logic based on this inverter configuration was known as resistor-transistor logic (RTL).  
The next level of sophistication entails replacing the load resistor with a transistor — either a depletion-mode or an enhancement-mode NMOS device.  This was done to ensure greater control over the effective load resistance and to significantly reduce layout area when implemented in an integrated circuit.  
Finally — and, by far, the predominant configuration in modern IC design — a PMOS device is used as the load instead of a resistor or an NMOS device.  This configuration, comprised of an NMOS driver and a PMOS load, is referred to as CMOS, short for complementary MOS.  The properties of CMOS inverters will be explored in subsequent labs.  
The ideal inverter has a switching threshold at halfway between the two supply voltages (one of which is commonly ground).  A discussion of the design and analysis of inverters can be found in Analysis and Design of Digital Integrated Circuits, by Hodges, Jackson, and Saleh, 3rd ed., McGraw-Hill, Chapter 4.

Although you should understand that RTL and depletion-mode or enhancement-mode NMOS logic have been superseded by CMOS logic in the design and manufacturing of digital integrated circuits, there is nonetheless great learning value in exploring the voltage transfer characteristics of these earlier logic types.  They are somewhat simpler to analyze, particularly RTL logic, yet they are still illustrative of the principles governing and limiting the operation of CMOS inverters and logic.

Pre-Lab

Before coming to lab, do all of the following (Parts (1)–(4)):  


Part 1:  Theoretical Analysis of the Resistive-Load Inverter
Consider a Resistive-Load Inverter such as the one shown in Figure 1.  

(
Derive an expression for the slope 
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 of the Voltage Transfer Characteristic (VTC) for the specific condition where Vin = Vout = VS.  Take the load resistor value R to be a variable, not the fixed value of 1 k( shown in Figure 1.  Your expression should be a function of VT0, k’, W, L, VDD, and R, but not a function of Vin or Vout.  Use the long-channel equations for the NMOS device (Equations (2.17b) and (2.19) in Hodges, Jackson, and Saleh).  Do not attempt to include channel-length modulation or velocity saturation effects.  
(
Using your expression for S, obtain expressions for 
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(
Lastly, do some analysis to answer this question:  Is the point where Vin = Vout = VS the condition of maximum |S|?
Part 2:  Simulation of a Resistive-Load Inverter
Objective:  Investigate the impact of (1) the value of the load resistor, and (2) the W/L ratio of the drive transistor on the Voltage Transfer Characteristic (VTC) of the Resistive-Load Inverter shown in Figure 1.

[image: image4.emf] 

M1  

1 kΩ  

V2  

R  

0 Vdc  

MbreakN  

5  Vdc   V 1  

V probe         ( V out )  

V probe         ( V in )  


Figure 1.  Resistive-Load Inverter

Use the directions and suggestions given in the following paragraphs in order to simulate the Resistive-Load Inverter circuit of Figure 1.  You may refer to Appendix A for a tutorial on the mechanics of using PSPICE if you need a refresher.  

Open Capture CIS on the computer.  Pull down on the File menu and select New ( Project.  Enter a name, select “Analog or Mixed A/D”, and create a blank project.  Using various libraries as indicated in the following, place parts and construct the RTL circuit:


(
Use part MbreakN4 from the BREAKOUT library for the NMOS driver.  

(
Use the resistor from the ANALOG library. 

(
Use the voltage sources from the SOURCE library.

(
Ground can be added by clicking on the ground symbol on the right of the screen — use GND/CAPSYM.  Once you’ve added the ground symbol, double click on it and change the name from GND to 0 — otherwise the simulation will fail.
Set the VDD power supply (V1 in Figure 1) to 5 V, and the input (V2) to 0 V.  Place voltage probes at the appropriate locations.  
Before running the simulation, you must establish the transistor parameters.  For the initial run, use VT0 = 0.7 V, k’ = 50 (A/V2, W = 25 (m and  L = 0.25 (m.  To set the VT0 and k’ parameters, select the transistor, then from the Edit menu select Pspice Model.  You will see a window with the line:

.model Mbreakn NMOS

Add parameters to this line as follows:

.model Mbreakn NMOS vto=0.7 kp=50e-6
Note:  The parameter VT0 is written in model statements as vto, where the third character is the letter “o”, not the number 0 (zero).  Also, the k’ parameter is written as kp, where the character “p” indicates the prime symbol, not a p-type device.  (If the data that you add to the model statement takes more than one line, then the additional line(s) must begin with a plus sign (+) in order for the model to include the additional data during simulation.)  Save the model information, and then close the model and return to the schematic.  
The remaining two parameters — W and L — could also be set in the .model statement for this simple circuit.  However, when a parameter is set in the .model statement, all instances of the component (part) using that model have the same set of parameters.  When there is only one instance of a given component, as in the resistive-load inverter, this is acceptable.  When there is more than one instance of a component — e.g., in the saturated enhancement load inverter of Part (3), which has two instances of the MbreakN4 part —  it is commonly necessary to specify different W and L values for each instance.

Therefore, for the NMOS driver, set the values of W and L in the following manner:  Select the part by clicking on it once.  Pull down the Edit menu and choose Properties.  (Alternatively, right-click on the selected part and choose Properties OR simply double-click the part on the layout.)  Each of these three approaches will cause a screen to appear having many fields, so many that they will scroll off the right side of the screen.  Search for the L and W fields and enter the desired values.  Note that this will set the W and L values for only the selected part.  Close the Properties screen and return to the schematic.
Create a simulation profile (pull down the PSpice menu), giving it a name of your choosing.  Choose the analysis type to be DC Sweep, and indicate the name of the input source (e.g., V2).  Use a linear sweep from 0 to 5 V.  Choose a reasonable voltage sweep increment so as to ensure a smooth VTC curve with good resolution.  (The smaller the increment, the more points taken and the better the resolution at the cost of simulation time — not a problem for our small example here.)  
(
Run the simulation and view the results.  Did your results look like what you would expect from an inverter?  What parameters can you change to achieve better inverter characteristics?  Consider the outcome of your theoretical analysis in Part (1).
(
Try changing the load resistor value and re-running the simulation until you can achieve results that look like a good inverter — i.e., one with a sharp transition between VOH and VOL.

(
Run a series of simulations to obtain values of VOL, VIH, VIL, NMH, NML, and VS as a function of load resistance, where VS is the voltage such that Vin = Vout = VS.  (Obtain the values from your simulations and create the plots using Excel, e.g.)  Keep the transistor width, W, set at 25 (m.  Does the trend agree qualitatively with the theoretical analysis of Part (1)?  The resistor value can be varied up to 100 kΩ.  Higher values have little perceptible effect on the VTC.
(
Run another series of simulations to obtain values of VOL, VIH, VIL, NMH, NML, and VS as a function of transistor width, W.  Create plots of these values vs. W.  Keep the load resistor value set at 1 k(.  Does the trend agree qualitatively with the theoretical analysis of Part (1)?
Make sure that you save/print any schematic diagrams and simulation results that are needed before modifying your circuit!!

Part 3:  Simulation of a Saturated Enhancement Load Inverter
Objective:  Investigate the impact of (1) source-substrate bias (body effect), and (2) the relative W/L ratios of the drive and load transistors on the Voltage Transfer Characteristic (VTC) of the Saturated Enhancement Load Inverter shown in Figure 2.
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Figure 2.  Saturated Enhancement Load Inverter

In this configuration, the resistive load used in Part (2) is replaced by an enhancement-mode NMOS transistor operating in the saturation region.  Operation of an enhancement device in the saturation region is guaranteed by wiring the gate and drain together.  Use part MbreakN4 again, and take care to ensure that all NMOS substrate (body) connections are wired to the lowest system supply voltage — in this case, ground.  Edit the parts’ models and properties in the same manner as in Part (2) as necessary.  Use L = 0.25 (m for both the driver and load transistors in these simulations.  Use W=25 (m for the driver (M1) and W=5 (m for the load (M2) in the initial simulation. 
(
Run the simulation, and record VOH, VOL, VIH, VIL, NMH, NML, and VS.  
(
Modify the model for the NMOS devices to account for source-to-substrate bias (body effect).  Edit the model and add 2(F = 0.65 V (phi=0.65 in the .model statement) and ( = 0.8 V1/2 (gamma=0.8 in the .model statement).  (The default for phi is 0.6, and the default for ( is 0.)  Repeat the simulation and compare these new results with the previous outcome.  How did the body effect change the results?

(
Calculate the theoretical value of VOH , accounting for body effect, and compare to the simulated value.  

(
With the new settings for phi and gamma, determine the impact of the ratio
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 by varying that ratio and plotting VOH, VOL, VIH, VIL, NMH, NML, and VS as a function of KR.  You could fix W1, for example, and vary W2, since only the KR ratio matters and the k’ value is the same for both NMOS transistors.  
Part 4:  Simulation of a Linear Enhancement Load Inverter
Objective:  Investigate the impact of the relative W/L ratios of the drive and load transistors on the Voltage Transfer Characteristic (VTC) of the Linear Enhancement Load Inverter shown in Figure 3, particularly VOL.  The advantage of this more complicated configuration is that VOH can be as high as VDD, unlike the simpler Saturated Enhancement Load Inverter.
In this configuration, the load is again an enhancement-mode NMOS transistor.  However, in this case the load transistor is biased so as to enable the output to pull up all the way to VDD.  This is accomplished by using a separate DC supply (VGG) for the gate of the load transistor.  One consequence of this biasing scheme is that the load operates in the linear region over a portion of the VTC where Vin is relatively low.  You can either modify the schematic of Part (3) or start fresh with a blank schematic.  
Make sure that you save/print any schematic diagrams and simulation results that are needed before modifying your circuit!!
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Figure 3.  Linear Enhancement Load Inverter

If you start over, use the MbreakN4 part again, and take care to ensure that all NMOS substrate (body) connections are wired to the lowest system supply voltage — in this case, ground.  Edit the parts’ models and properties in the same manner as in Parts (2) and (3) as necessary.  If you are modifying your previous circuit, disable body effect by making gamma=0 in the .model statement.  Use L = 0.25 (m for both the driver and load transistors in these simulations.  Use W=25 (m for the driver (M1) and W=5 (m for the load (M2) in the initial simulation.
(
Calculate the minimum value required for VGG in order to have VOH = 5 V.  This is easily calculated by considering the body effect in transistor M2.  In the following simulations, set the value of VGG to be 0.5 V above your calculated minimum value.  

(
Run the simulation, and record VOH, VOL, VIH, VIL, NMH, NML, and VS.  

(
Incorporate body effect by adding gamma=0.8 and phi=0.65 to the .model statement as in Part (3).  Run the simulation again, and record VOH, VOL, VIH, VIL, NMH, NML, and VS.  

(
Suppose we wish to have VOL ( 1% of VDD. Determine the value of KR for which VOL ≈ 0.01VDD and state whether this is a minimum or a maximum value for KR.  (Keep gamma=0.8 and phi=0.65.)
(
Compare VOH, VOL, VIH, VIL, NMH, NML, and VS for the Saturated Enhancement Load and Linear Enhancement Load Inverters.  Make sure that you are comparing simulations where both inverters have the same KR values and the same values for gamma and phi.  Which one would you consider to be the better inverter?  Explain your reasoning.  
Lab — Measurement of Inverter Characteristics
In this lab, we will build and measure certain characteristics of two different NMOS–based inverter configurations using transistor(s) that are contained in the ALD1103 chip.  Refer to Figure 4(a) for the chip pin-out.  Pay particular attention to the substrate connections for the NMOS and PMOS devices, pins 4 and 11, respectively.  

Note that there are two NMOS and two PMOS devices on each chip.  (We will not be using the PMOS devices in Lab #1.)  Note also that the p-substrate connection (pin 4) is common to the two NMOS devices;  likewise, the n-substrate connection (pin 11) is common to the two PMOS devices.  

Important:   Do not apply voltage to the gates (pins 2, 6, 9, and 13) before the drains, sources, and substrates are connected.  The gates must be connected last to avoid damage from static discharge.  When deconstructing your circuits, the gates must be disconnected first.  
Required Electronic Components:

2 — ALD1103 chips
Miscellaneous discrete resistors, ranging from 1 kΩ to 100 kΩ
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ALD1103

DUAL N-CHANNEL AND DUAL P-CHANNEL MATCHED MOSFET PAIR

GENERAL DESCRIPTION

The ALD1103 is a monolithic dual N-channel and dual P-channel matched
transistor pair intended for a broad range of analog applications. These
enhancement-mode transistors are manufactured with Advanced Linear
Devices' enhanced ACMOS silicon gate CMOS process. It consists of an
ALD1101 N-channel MOSFET pair and an ALD1102 P-channel MOSFET
pair in one package.

The ALD1103 offers high inputimpedance and negative currenttemperature
coefficient. The transistor pair is matched for minimum offset voltage and
differential thermal response, and it is designed for precision signal
switching and amplifying applications in +2V to +12V systems where low
input bias current, low input capacitance and fast switching speed are
desired. Since these are MOSFET devices, they feature very large (aimost
infinite) current gainin a low frequency, or near DC, operating environment.
When used in pairs, a dual CMOS analog switch can be constructed. In
addition, the ALD1103 is intended as a building block for differential
amplifier input stages, transmission gates, and multiplexer applications.

The ALD1103 is suitable for use in precision applications which require
very high current gain, beta, such as current mirrors and current sources.
The high input impedance and the high DC current gain of the Field Effect
Transistors result in extremely low current loss through the control gate.
The DC current gain is limited by the gate input leakage current, which is
specified at 50pA at room temperature. For example, DC beta of the device
at a drain current of 5SmA at 25°C is = 5SmA/50pA = 100,000,000.

FEATURES

» Thermal tracking between N-channel and P-channel pairs
Low threshold voltage of 0.7V for both N-channel &
P-channel MOSFETS

Low input capacitance

Low Vos — 10mV

High input impedance — 10132 typical

Low input and output leakage currents

Negative current (IDs) temperature coefficient
Enhancement mode (normally off)

DC current gain 10°

Matched N-channel and matched P-channel in one package

ORDERING INFORMATION

Operating Temperature Range*
-55°C to +125°C 0°C to +70°C 0°C to +70°C
14-Pin 14-Pin 14-Pin
CERDIP Plastic Dip SoIC
Package Package Package
ALD1103 DB ALD1103 PB ALD1103 SB

* Contact factory for industrial temperature range.

APPLICATIONS

* Precision current mirrors
Complementary push-pull linear drives
Analog switches

Choppers

Differential amplifier input stage
Voltage comparator

Data converters

Sample and Hold

Analog inverter

Precision matched current sources

PIN CONFIGURATION
DN1 [T ~ 14] DN2
GMN1 ET" E:—E GN2
SN1 [Ij r_@ SN2
v [@] 1] v+
oP1 5] 18] DP2
GP1 ET—] L_;E GP2
SP1 IIj r—E sP2

DB, PB, SB PACKAGE
BLOCK DIAGRAM

N GATE 1(2)

NDRAIN1(1) o—) | Lo NSOURCE1(3)

| SUBSTRATE (4)

NDRAIN2(14) o— | —o NSOURCE2(12)

=

N GATE 2 (13)

P GATE 1 (6)

PDRAIN1(5) o— | L—o PSOURCE1(n) "

——0 SUBSTRATE (11)

P DRAIN 2 (10) o—L__rO P SOURCE 2 (8)

=

P GATE 2 (9)

© 1998 Advanced Linear Devices, Inc. 415 Tasman Drive, Sunnyvale, California 94089 -1706 Tel: (408) 747-1155 Fax: (408) 747-1286 http://www.aldinc.com




Figure 4(a).  ALD1103 Pin-Out and Specifications
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Figure 4(b).  ALD1103 Absolute Maximum Ratings and Operating Electrical Characteristics

(Parts (1)–(4) were done as part of the Pre-Lab preparation)
Part 5:  Resistive-Load Inverter

Important:  The gates must be connected last and disconnected first.  (See above)
Build the Resistive-Load Inverter of Figure 1, which is replicated below.  Use one NMOS transistor from the ALD1103 chip.
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(Replication of:   Figure 1.  Resistive-Load Inverter)
(
Measure the voltage transfer characteristic (VTC) of your inverter.  Rather than laboriously taking individual pairs of (Vout, Vin) data, sweep the input (V2 in Figure 1) from 0 V to 5 V with a saw tooth or triangle waveform and use the oscilloscope to capture and display Vout vs. Vin.

(
Determine VOH, VOL, VIH, VIL, NMH, NML, and VS from your data.

(
Change the load resistor from 1 k( to 10 k(, then repeat your measurements and analysis.  

Part 6:  Saturated Enhancement Load Inverter with Body Effect
Important:  The gates must be connected last and disconnected first.  (See above)
Build the Saturated Enhancement Load Inverter of Figure 2, which is replicated below.  Use the two NMOS transistors from a single ALD1103 chip.  Note that their substrates are tied together.
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(Replication of:  Figure 2.  Saturated Enhancement Load Inverter)
(
Measure the voltage transfer characteristic (VTC) of your inverter.  Rather than laboriously taking individual pairs of (Vout, Vin) data, sweep the input (V2 in Figure 2) from 0 V to 5 V with a saw tooth or triangle waveform and use the oscilloscope to capture and display Vout vs. Vin.

(
Determine VOH, VOL, VIH, VIL, NMH, NML, and VS from your data.

(
Compare the VTC from the Resistive-Load Inverter to the VTC from the Saturated Enhancement Load Inverter.  
Part 7:  Saturated Enhancement Load Inverter without Body Effect

Important:  The gates must be connected last and disconnected first.  (See above)
Build the Saturated Enhancement Load Inverter shown in Figure 5.  Pay close attention to the body connections.  Two separate ALD1103 chips must be used, because the NMOS substrates are tied together on each chip.
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Figure 5.  Saturated Enhancement Load Inverter without body effect
(
Measure the voltage transfer characteristic (VTC) of your inverter.  Rather than laboriously taking individual pairs of (Vout, Vin) data, sweep the input (V2 in Figure 2) from 0 V to 5 V with a saw tooth or triangle waveform and use the oscilloscope to capture and display Vout vs. Vin.

(
Determine VOH, VOL, VIH, VIL, NMH, NML, and VS from your data.

(
Compare the VTC of the Saturated Enhancement Load Inverters from this part and Part (6).  
Tech Memo
Discuss the impact of design parameters on inverter operation.  Analyze the performance of the inverters using the simulation data.  Include a copy of the schematics, and all graphs requested in the pre-lab preparation.  Summarize the results from your experimental measurements.  All information detailed on the check-off sheet should be included in a logically and professionally-organized fashion and briefly discussed.

Check-Off Sheet
A.  Pre-Lab

· Theoretical analysis of resistive-load inverter.

· Resistive-Load Inverter:  (a) schematic;  (b) initial VTC;  (c) improved/optimized VTC; (d) plots of VOL, VIH, VIL, NMH, NML, and VS  vs. R;  (e) plots of VOL, VIH, VIL, NMH, NML, and VS  vs. W. 
· Saturated Enhancement Load Inverter:  (a) schematic;  (b) VTC without body effect (( = 0); (c) VTC with body effect;  (d) calculation of theoretical value of VOH and comparison to simulation result;  (e)  plots of VOH, VOL, VIH, VIL, NMH, NML, and VS vs. KR.
· Linear Enhancement Load Inverter:  (a) schematic;  (b) calculation of VGG;  (c) VTC without body effect (( = 0); (d) VTC with body effect;  (e) determination of KR required to achieve VOL ≈ 0.01VDD;  (f) comparison of VOH, VOL, VIH, VIL, NMH, NML, and VS for Saturated and Linear Enhancement Load Inverters.   
B.  Experimental

· Resistive-Load Inverter:  (a) VTC for R = 1 k(; (b) values of VOL, VIH, VIL, NMH, NML, and VS  for R = 1 k(;  (c) VTC for R = 10 k(;  (d) values of VOL, VIH, VIL, NMH, NML, and VS  for R = 10 k(. 
· Saturated Enhancement Load Inverter with Body Effect:  (a) VTC;  (b) values of VOL, VIH, VIL, NMH, NML, and VS ;  (c) comparison to Resistive-Load Inverter VTC.
· Saturated Enhancement Load Inverter without Body Effect:  (a) VTC;  (b) values of VOL, VIH, VIL, NMH, NML, and VS ;  (c) comparison of VTC to Saturated Enhancement Load Inverter with body effect.
TA Signature: ____________________________ Date: ___________________________
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Appendix A — PSPICE Guidance
Capture CIS Reference Guide
(This helpful reference guide was drafted by Reuben Mathew in Spring 2004.  
You may also wish to refer to a similar guide at the lab website for EE381:  Circuits I.)
Starting a New Project in Capture CIS
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Start menu ( Programs(Cadence PSD 15.0(Capture CIS

2) When the pop-up appears, choose the “PCB Design Studio with Capture CIS”, and click OK. 

3) [image: image21.jpg]Under “File” menu, choose New ( Project
4) Fill in the wizard.  Note that the screen captured below refers to Lab #4;  you will want to indicate Lab1 to avoid confusion.   You may also wish to make the destination directory “C:\Temp\” instead of “C:\Lab482”.   Be absolutely sure that you choose “Analog or Mixed A/D”.
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For simplicity choose empty_all_libs.opj.
6) Expand your “File” hierarchy to select “PAGE1” under “Schematic”
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7) Double click on PAGE1 to open up your first schematic page. 

8) Now you are ready to make your own schematics. 
Drawing your Schematic
To start, you need a basic introduction to the toolbars.  The manual has everything, but it may be easier to take a quick glance at the following:
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1) Select the parts you need.  If you chose empty_all_libs.opj  in step #5 above, you should have every part available and ready for use. 

You should be careful to choose parts from the PSPICE library since you need PSPICE parts to run a simulation. The library can be located via the following path:

D:\Cadence\PSD_15.0\tools\capture\library\Pspice
2) For purposes of illustration, consider Lab #5 of Electronics 482.
We need MOSFET devices, and the parts we are interested in can be found in the 
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 “Place Part” Menu on the toolbar.
MbreakN 

: Nmos Device

MbreakP

: Pmos Device

C

: Capacitance

R

: Resistor

VDC

: DC source

VAC 

: AC source
Gnd (For GND use the “0/SOURCE” found in 
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  “Place Gnd” menu in the toolbar)
Once you find these parts your schematic would look like this. [image: image27.jpg]Create PSpice Project
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3) It’s a good idea to first set the properties of the MbreakN and MbreakP parts.  Double click on the MbreakN part, select the L (length) property, enter a value, then press “Display” button (Upper left, three rows below “File” menu) and set the property as “name and value”. Do the same with the W property: select the W property, enter a value, then press “Display” button and set the property as “name and value”. This is useful especially when you have various W/L ratios and you want to see them on the schematic. Do the same for the MbreakP part. 
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4) Select the MbreakN model by clicking once on it, and then from the “Edit” menu select “PSPICE model”. This is where you will enter your extracted model parameter values for the NMOS and PMOS devices.  In the screen shot shown below, the “+” sign is a line continuation and should be first on every line except the “.model” line.  The SPICE parameter names that you need are as follows:

version = 2
VTO for Vt (note that the “O” is a letter, not a numeral)
KP for k’ (the P in KP stands for “prime”, not PMOS)
GAMMA for (
LAMBDA for (
NSUB for Nsub (use your value of Nsub from mobility data)
TOX for tox

You do not need to specify any other parameters;  they will default to acceptable pre-set values.

Click on the Save icon 
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 in the model editor, then close the editor.  Repeat for the MbreakP model.
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5) Now use the 
[image: image16.png]


 “Draw Wire” to connect the circuit diagram as needed. A final diagram (for Lab #5) is shown below.

Running a Simulation

1) Create a “new simulation profile” by clicking on 
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Set the “simulation parameters” by clicking on 
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 as shown. 

3) Finally click on the 
[image: image19.png]


 “Run Simulation” icon to  run the simulation. 

4) If you get an error, it will probably be a wire that was not connected properly. Use the “PSPICE” menu and use the “View Netlist” option.  This will give you an idea on which node is floating on the schematic. 

5) Use the Current, voltage and differential voltage markers to view results at any point on the schematic. Current and power dissipation markers must be connected to a pin. 
6) Use the plot options toolbar to mark and annotate your results. 
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7) Use the User Guide and Manual!  

Remember this table of abbreviations, and note that M is “milli” (10-3), not MEGA (106). 
	Prefix
	Pspice

	Giga
	G

	Mega
	Meg

	Kilo
	K

	Milli
	m

	Micro
	u

	Nano
	n

	Pico
	p

	Femto
	f


(End of Appendix A)
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